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Introduction 
 
Welcome to Capsim. This is a tutorial that will expose you to many of Capsim's features. 
In the tutorial, we will examine the impulse response of a digital low pass filter. Next, we 
will observe the response of the filter to two sine waves at different frequencies. Finally, 
we will build a staircase generator Hblock (Hierarchical Block)  from simple blocks.  
Other Capsim topics including logic analyzers, multi-plots, complex buffers, multi-rate 
signal processing and creating HBlocks from existing topologies will be presented. 
 

Running Capsim 
 
To begin Capsim, type: 
 
     $CAPSIM/BIN/capsim 
 
Note: The environment variable CAPSIM must be set to the path where CAPSIM is 
installed. For example,  
 
      export CAPSIM=/usr/local/CAPSIM_V6_RELEASE 
 
Important Note: When you run Capsim a window will appear for graphical block 
diagram development. The console will display messages and also is the TCL interpreter 
with the ‘%’ prompt. Make sure you position the console so you can enter commands and 
view messages and simulation results  in the console.  
 
 
The screen will display a pull-down menu bar as shown in  Figure 1. You will need to 
switch between the console and the Capsim workspace on some occasions. To display a 
new workspace in Capsim, select “New” from the File menu. An empty workspace will 
be displayed.  
 
Before we proceed, exit Capsim using the File menu exit command or type exit in the 
console (in TCL mode). To work with this tutorial it is recommended that you create a 
directory and store all your work in that directory.  
 
To make a directory, say, WORK type: 
 
     mkdir WORK 
 
Then change directories to WORK (cd WORK). Type pwd to see the current working 
directory.  
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Figure 1 Capsim Pulldown Menu Bar and Console 

 
In the first part of this tutorial, we will place the following blocks on the workspace: an 
impulse block, to generate an impulse; an iirfil block, to simulate an IIR digital filter; and 
a spectrum block to plot the impulse response and frequency response of the filter. Later, 
we will replace the impulse block with a sine wave generator block in order to observe 
the low pass IIR filter's response to two tones at difference frequencies.  
 
 
 

Placing Blocks on the Workspace 
 
To begin, move the cursor to the Blocks menu in the pull-down menu bar. Select Blocks 
…   (See Figure 6). The Capsim block selection box (Block List window) will appear as 
shown in Figure 2.  
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Figure 2 Capsim List of Blocks 

 

 
 
Move the Block List window to a convenient location on the screen so that most of the 
workspace is visible. (You can do this by first placing the mouse on the top bar  in the 
Block List window and then dragging it to the new location with the left mouse button 
down.)  You can also activate the block list by clicking on the Blocks icon in the 

workspace tool bar . If you wish you may resize the workspace to any size you 
desire. To place a block on the workspace, find the block in the block list, click on its 
name and then click on the Place button ( you can also select it by typing its name in the 
text field). You can scroll through the block list using the scroll bar. To begin, find the 
impulse block. Click the mouse button to highlight it. ( The Selection box should display 
impulse). Now, click on the Place button. Move the cursor to the workspace. Notice that 
the cursor has now changed to a hand cursor. Observe the layout in Figure 3. Move the 
hand (place) cursor to the left of the workspace as shown. Click the mouse button. The 
impulse block will appear on the workspace. If your paths are setup you will see an 
impulse icon. Otherwise a block will appear with impulse written in it.  Now, get the iirfil 
and spectrum blocks from the block list and place them on the workspace as shown in 
Figure 3.  After you have placed the blocks, move the cursor to the Block List window's 
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cancel button and press the left button to get rid of this window since we don't need it for 
now.  
 

 
Figure 3 Block layout for impulse, iirfil and spectrum 

 

 

Connecting Blocks 
 
There are several ways to connect blocks. We will first try the auto connect mode  with 
no fast connect. We will explain fast connect later. To connect the impulse block to the 
iirfil block,  move the mouse over to the impulse block so that it is highlighted ( a box 
appears around the icon). Now click the left hand mouse button. A popup menu appears 
as shown in Figure 4. This popup menu allows you to do many things with the block. For 
now, just move the cursor so that the Connect an Output option is highlighted. To select 
this option, click the right hand mouse button. The popup menu will disappear and the 
cursor will change to a question mark. The reason for the question mark is that Capsim 
needs to know which block you want to connect to. Move the cursor over to the iirfil 
block so that it is highlighted. Now click on the left hand mouse button. The impulse 
block is automatically connected to the iirfil block.  Repeat the same procedure to 
connect the iirfil block to the spectrum block. Your topology should be as shown in 
Figure 5. We are now ready to run a simulation. 



(c)1989-2016 Silicon DSP  Corporation 9 Capsim Tutorial 

 

 
Figure 4 Block Popup Menu 
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Figure 5 Connected Blocks 

 
 

 
Note, when you click on a Block and the block popup menu appears, make sure that you 
select Exit Menu to exit the menu if you do not make a selection. Otherwise, you may 

need to click the refresh icon,   to be able to select the menu again.  

Running a Simulation 
 
Move the cursor to the pull-down menu bar and select Blocks. Place the cursor on the 
Run option and press the left hand mouse button. See Figure 6. Or you can click on the 

Run icon in the workspace toolbar . The impulse response in Figure 7 and the 
frequency response in Figure 8 will appear. The two plots are independent windows that 
are stacked on top of each other. Move them around for a better view. You can also use 

the plot shuffle tool  to view the plots.  
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Figure 6 Blocks Menu 

 
 

 
Figure 7 Filter Impulse Response 
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Figure 8 Filter Frequency Response 

 
 

 
Place the cursor in the impulse response plot. Click the left mouse button to select the 
plot.  In many DSP applications it is appropriate to display the plots such that the discrete 
nature of the plot is highlighted. To do this, click on the plot to display the plot popup 
menu as shown in Figure 9.  Select Curve Style. The dialog box in Figure 10 appears. 
Select Bar from the Curve Style radio button group and click Okay. The impulse 
response will change to a discrete sample plot (bar chart) as shown in Figure 11. Note 
that you can set all curves to draw bar charts by default. More on this later (Use save plot 
layout in File pulldown menu and load it again or store it as default). 
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Figure 9 Plot Popup Menu 

 
 
 
 



(c)1989-2016 Silicon DSP  Corporation 14 Capsim Tutorial 

 
Figure 10 Plot Style Dialog 
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Figure 11 Impulse Response with Bars to Highlight Discrete Samples 

 
 
Another option is to display the frequency response in dB’s. To do this select the 
frequency domain plot by clicking in the plot area and select Select/Exit (or Redraw) to 
make the plot the current selected plot. Next select “Create DB New Curve” from the Plot 
menu. See Figure 12. A new plot with the magnitude in DB will appear as shown in 
Figure 13. (You can also set the spectrum block to produce magnitude in dB). 
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Figure 12 Create dB Plot Menu Item 
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Figure 13 Frequency Response in dB’s 

 

Errors During a Run or Editing 
 
Capsim will inform you of errors through the console window. Read the message and 
correct the error. At this stage of the game it is probably better to start all over again. 
 

Manipulating Plots 
 
You can do many things to the plots such as zoom in and zoom out, change the axis and 
title labels, change the plotting style to bar charts, etc. Check out the options available for 
each plot. For now, we are interested in deleting the two plots we just created. Select the 
edit menu from the   pull-down menu. Select “Delete All Plots”. The two plots will 
disappear. Note that there is no warning. In Capsim, you will usually perform a lot of 
simulations comparing results, changing parameters and running simulations again and 
again. You will appreciate the no warning! When deleting ,multiple plots a warning is 

given. You can use the delete plots tool from the tool bar. 
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Replacing Blocks 
 
In the following sequence, we will replace the impulse block with the sine block so that 
the response of the low pass filter to two tones at different frequencies can be simulated. 
One tone will be in the filter pass band and the other will be in the filter stop band. The 
responses will be compared using the group plot facility.   
 
To replace the impulse block with a sine block, move the cursor to the impulse block so 
that it is highlighted. Click the left mouse button. The block popup menu will appear as 
before. Move the cursor to the Replace option. Place it over the arrow (->). A popup 
menu appears as shown in Figure 14. Move the cursor horizontally so that it highlights 
the Blocks option. Now press the mouse button. The Block List window will appear 
again. Move it over to a convenient location. Now, scroll through the block list and find 
the sine block. Click on it. Then click the Place button.  The impulse block is replaced 
with the sine block as shown in Figure 15. After the block has been replaced cancel the 
Block List  window by clicking on the Cancel button. 
 

 
Figure 14 Replace Sub-Menu 
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Figure 15 Impulse Block Replaced by Sine Block 

 

 
 
 
 
 
Run a simulation by the procedure described before. Two plots should appear. In one 
plot, the time domain response appears. In the second plot the frequency domain plot 
appears. The IIR filter implements a low pass filter with 35 dB attenuation at 4.4 kHz. In 
the next section we will investigate the response of the filter to two sine waves at 1000 
and 5000 Hz. Note that the sampling rate is 32000 Hz for both the sine and iirfil blocks. 
You may also change the sampling rate parameter in the spectrum block to 32000 Hz so 
that the x axis displays Hz. 
 
 

Block Parameters 
 
The frequency of the sine block was 1000 Hz. The number of points generated was 128. 
To see what the parameters of the sine block are, move the cursor to the sine block and 
click the mouse. The popup menu will appear. Move the cursor to the Change 
Parameters  menu item and click the left mouse button.   The sine block parameter box 
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will popup. The definitions and the values of the sine block parameters are displayed.  
This dialog box is useful when multiple simulations are run where a parameter is changed 
between simulations.  
 

 
Figure 16 sine Block Parameters 

 
 
Set the total number of samples to output to 1050. Click on OK. Run a simulation. Now 
delete the frequency response curve. Use the delete from the plot popup menu. The idea 
is to keep the time domain plot. Now display the parameters of the sine wave again as in 
Figure 16. Change the Enter Frequency parameter to 5000 Hz. Click on OK. Run the 
simulation again. Delete the frequency domain plot. The idea is to compare the filter 
response to a 1000 Hz tone to a 5000 Hz tone in the time domain. To do this, select 
Group Plots from the View menu in the menu bar. See Figure 17. The Group Plot Dialog 
box appreas. Select Time Domain Plots. Click on the Group Plots check box. Click on 
Okay. A new plot is generated in which you can compare the response of the filter to the 
two tones. See Figure 19. 
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Figure 17 Plot Menu 
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Figure 18 Group Plot Dialog 
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Figure 19 Comparison of Filter Response to 1000 Hz  and 5000 Hz Sine Wave 

 
 

Saving the Topology 
 
It is time to save your work. Select the File option from the Capsim pulldown menu. The 
File pulldown menu should appear. Select the “Save Topology As ... “ option. A dialog 
box should popup requesting the name of the topology. Type in sinetest and then click on 
the OK button ( you can name it whatever you like). The topology has now been saved. If 
you make any more modifications and wish to save the changes, just use the Save 

Topology option in the File pulldown menu, or use the save icon  in the topology 
toolbar. Make sure to save it in the current directory (WORK). 
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To exit Capsim, select the Exit menu item from the Capsim File pulldown menu. NOTE: 
THERE IS NO WARNING WHEN YOU EXIT CAPSIM. The reason for this is that in 
the Capsim model for  design and simulation you enter and exit Capsim often. Changing 
code, rebuilding etc. After a while the nagging warning dialogs become a pain. So save 
your work often and be a power user! 
 
 

Creating an Hblock (Hierarchical Block) 
 
Capsim is a hierarchical block diagram simulator. Complex blocks can be made of 
existing blocks. These blocks are called HBlocks. HBlocks can contain other HBlocks as 
well as blocks. In this tutorial, we will construct a staircase generator HBlock from three 
existing blocks. We will implement a pure integrator and drive it with periodic impulses.  
 
Startup Capsim again from scratch (exit from the current session and start Capsim from 
the command line). Select New from the File menu. Place the add, delay and node blocks 
on the workspace as shown in Figure 20.  The delay block is indicated by the z-N icon and 
the node block by the small square. The delay block  delays its input samples by an 
amount specified by its parameter. The default is 1 sample delay which is what is needed 
in the staircase HBlock. Thus, we don't need to change its parameter. The node block is 
useful when more than one buffer needs to be connected to a block’s output. That is, the 
node block takes the samples from its input buffer and forks them out to as many output 
buffers that are connected. 
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Figure 20 HBlock Bock Layout 

 
 

 

HBlock Input Terminal 
 
An HBlock needs to receive and send samples to the blocks that are connected to it. The 
mechanism through which samples are input and outputted from an HBlock are the 
input/output terminals.   
 
We need to connect an  input terminal to the add block as shown in Figure 22. To do this, 
click on the add block. Select “Connect an Input” from the popup menu (Figure 21). 
When the cursor changes to "?", move it to the left of the add block and click on an 
empty space in the workspace. The terminal connection in Figure 22 results.  



(c)1989-2016 Silicon DSP  Corporation 26 Capsim Tutorial 

 
Figure 21 Connecting an Input Terminal (Select Workspace) 
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Figure 22 Input Terminal Connected 

 
Next connect the add block to the node block. See Figure 23. Connect the node block to 
the delay block  as shown in Figure 24. Connect the delay block to the add block as 
shown in Figure 25. Finally connect an output terminal to the node block. To do this, 
click on the node block. Then select “Connect an Output”. Next click on an empty point 
in the workspace to the right of the node block. An output terminal will appear as shown 
in Figure 26. 
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Figure 23 Connect add Block to node Block 
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Figure 24 Connect node to delay 
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Figure 25 Connect delay to add Block 
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Figure 26 Connect node to "Workspace" for Output Terminal 

 
 
Now that you have created the HBlock, you must save it. Select the “Save Topology As 
... “ from the Capsim File pulldown menu. When prompted for a topology name type 
integ  in the text field. Click on OK.   
 
 

Manual Connections 
  
This section is optional. On most occasions Capsim’s automatic connections are the best 
choice for connecting blocks. However, especially when feed back is involved, manual 
connections are necessary. The procedure is to let Capsim make the connection. Then 
click on the connection and select Redraw (same numbers) from the popup menu. See 
Figure 27. 
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Figure 27 Redrawing a Connection 

 
 
The pencil cursor indicates that you are in manual connect mode.  Move the pencil cursor 
to the add block as shown in Figure 28(b). Click the mouse button once ( do not hold 
down the mouse button). Now move the pencil cursor. A rubber band will follow the 
cursor. See Figure 28(c). Move the pencil to the node block  as shown in Figure 28(d). At 
this point, double click the mouse button. A line will be drawn with an arrow indicating 
that a connection has been made.  If there are any residuals on the screen, click on 
Redraw in the option box. 
 

Σ
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(b) 

Σ

Z -N
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(c) 

Σ
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Double Click Here

 
(d)  

Figure 28 Manual Redraw 

  
 
To make the connection from the node to the delay block, first move the delay block to 
the right as shown. Then click on the connection between the node block and delay block 
and select Redraw. The cursor will change to a pencil indicating that we are ready to 
make a manual connection. Place the pencil at the node block as shown in Figure 29(a). 
Click once. The rubber band should appear. Now move the pencil to the location shown 
in Figure 29(b). Click once. Move the pencil to the delay block as shown in Figure 29(c) 
and double click. A connection will be made.   
 
 

Σ

Z -N  Click Once

 
(a) 

Σ

Z -N
 Click Once

 
(b) 
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Σ

Z -N

 Double Click Here

 
(c) 

Figure 29 Manual Redraw Feedback 

 
 
 

 
Follow the same procedure to make the connection from the delay block to the add block. 
The final block diagram is shown in Figure 30.  
  

 
Figure 30 Delay Connections with Manual Drawing 
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Using a Hierarchical Block 
 
At this point, select Clear All from the File pulldown menu. Click OK on the warning 
dialog.  The workspace will disappear. You are ready to create the universe. 
 
Select New from the File pulldown menu. A new workspace will be created. We are 
going to create a topology as shown in Figure 31.  The topology is formed from the pulse 
block, the integ HBlock, and the plot block.  Layout the pulse and plot blocks as you did 
before by selecting Blocks from the Block pulldown menu and selecting the blocks from 
the Block List.  
 

 
Figure 31 integ HBlock with pulse and plot Blocks 

 

 
 
 

 

Placing HBlocks on the Workspace 
 
To place the integ HBlock on the workspace, select the HBlock option form the Block 

pull down menu. Or, click on the HBlock icon in the tool bar .  An HBlock List 
window will appear just as in the case for placing blocks. You should find the integ 
HBlock in the list. Move the window to a location so that you can place the integ HBlock 
onto the workspace. Select the integ HBlock from the list by clicking on it and then 
clicking on the Place button. Move the cursor to the workspace. It should turn into a hand 
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place  tool. Move it between the pulse and plot block. Click the mouse button. The integ 
HBlock appears. HBlocks appear with a double box.  Make the connections shown in 
Figure 31 using the procedure described before. Before we run some simulations we need 
to change the pulse block's parameters. Click on the pulse block (if in fast connect, click 
again). The pulse block popup menu will appear. Move to the parameters item and select 
it. The pulse parameter dialog box should appear. Change the samples per period to 10 
and the pulse width to 1. See Figure 32. Click on the OK button. You are ready to run a 
simulation. It is a good idea to save your work first, however, before any simulation just 
in case you crash. So save the universe as integtest for example.  Run the simulation. You 
should get a plot of a staircase as shown in Figure 33.  
 
 

 
Figure 32 pulse Block Parameters 
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Figure 33 Simulation Run with integ HBlock Showing Stair Case. 

 

Moving Down an HBlock 
 
The topology of the HBlock is also shown in Figure 33. In Capsim you can work on a 
number of HBlocks at once. To bring up a workspace with the integ HBlock, move the 
mouse to the integ HBlock. Click on the left button to popup the block menu. Select 
“Down One Level”. A workspace with the integ HBlock will appear. You can resize it if 
you wish. To make a workspace current when multiple workspaces are on the screen, 
move the mouse to an empty area on the workspace you want to make current. Click the 
left mouse button. You can now edit the workspace.  
 

Probes 
 
Probes are attached to connections to monitor the samples. They include a spectrum, plot, 
prfile to print samples to a file, hist a histogram generator and stat a statistics probe 
among others. To see how probes work, create a new workspace and layout the blocks 
shown in Figure 34. The blocks are, from left to right, the sine block, the addnoise block, 
and the prfile block.  Connect the blocks as shown. Note that the addnoise block simply 
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adds "white" Gaussian noise to its input samples and the prfile block by default prints the 
samples to the console. Hence, when you run a simulation, nothing seems to happen 
unless you monitor the console. The samples are printed to the console. To observe what 
is going on, let us attach a probe to the connection between the addnoise block and the 
prfile block. Move the cursor to this connection and click the left button on the mouse ( 
the connection must be highlighted by the appearance of  two squares at its endpoints). A 
connection popup menu appears as shown in Figure 35. 
 

 
Figure 34 Topology for Probe Insertion 
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Figure 35 Connection Menu 

 

 
Move the cursor to the Probes item and click the right mouse button. A Probe Dialog Box 
appears. See Figure 36. To enable a probe, click on the toggle box by its name. So click 
on the spectrum toggle to enable it. A probe will appear on the connection as shown  in 
Figure 36. Before you run a simulation, set the total number of samples parameter in the 
sine block to 1050. Now, run a simulation. Observe the time domain and frequency 
domain plots. Disable the spectrum probe and enable the hist probe. Run a simulation. 
You should get a histogram. Later, change the sine block amplitude parameters to zero. 
The histogram should appear as a bell shaped curve since the samples are Gaussian 
distributed.  
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Figure 36 Probe Dialog 

 

 
Probe parameters may be changed by clicking on the Change Parameters button. A popup 
menu will appear with a list of probes. Select the probe you want to change the 
parameters for (it must be enabled), and click the left mouse button. A parameter dialog 
box will appear for that probe. Change the parameters as described earlier. If you no 
longer need the probe dialog box click on OK or Cancel. You can delete all probes using 
the connection popup menu.  
 
Save your work! 
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Figure 37 Probe Simulation Results 

 
 
 
 

HBlock Parameters: Arguments 
 
The argument command establishes  a model for a HBlock parameters. The basic idea is 
illustrated in Figure 38. An HBlock is composed of interconnected blocks. These blocks 
may have parameters which are local. That is, the user of the HBlock does not need to 
change these parameters. On the other hand, some of the block parameters need to be 
accessible to the user of an HBlock. These parameters are made accessible through the 
arguments mechanism. Thus, each parameter that is "exported" from the HBlock is 
specified by arg n  instead of a value. The block will then get the parameter value from  
argument number n. See Figure 38.   
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Figure 38 HBlock Arguments 

 
It is clear that argument n must be defined prior to usage by the block. So the first step in 
using arguments, to specify HBlock parameters, is to define them. To do this, the 
Arguments item in the Blocks pulldown menu must be selected. Or you can click on the 

arguments icon from the tool bar . The dialog box shown in Figure 39 will appear. 
 

 
Figure 39 Argument Dialog Box 

 
 

 
 
 
 
 
Initially, there are no arguments. So you must click on the add argument button. This will 
cause the argument definition dialog box shown in Figure 40 to appear. Using  this dialog 
box, you select whether the parameter is an int, float, file, or array. You also define a 
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prompt and an initial value for the parameter. This new argument will then appear in the 
argument dialog box when you press Okay. The argument can always be modified at any 
time. The first argument created is arg 0 and so on. To access this argument in a block, 
you type arg0 for the parameter value. 
 
 

 
Figure 40 Argument Definition Dialog Box 

 
 

Global Parameters Through Arguments 
 
The use of arguments is not limited to HBlocks. A universe ( the top level HBlock) can 
also have arguments. In fact arguments can be used to set a global parameter for the top 
level universe. For example, the number of samples to generate and consume is the same 
for  several source blocks. Instead of specifying the same number of samples for each 
block, the parameter arg 0 is specified. Using the argument command the value and 
prompt for arg 0 is set. Then if the number of samples was changed, only arg 0 is 
modified. Otherwise, the parameter for each block must be changed individually. This 
concept is illustrated in Figure 38.  
 
In the next tutorial we will illustrate the use of HBlock arguments and global universe 
arguments.  
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Figure 41 Arg 0 

 
 
 

Creating HBlock Parameters Through Arguments 
 
In this section  we will analyze a channel with nonlinear distortion and additive Gaussian 
noise. The purpose of the tutorial is to show how parameters are created for a 
universe/HBlock. When the HBlock is used as a block, these parameters will be available 
to the user just as block parameters. We will further show how arguments can be used in 
a universe for global parameters. 
 
First we create the topology  shown in Figure 42.  
 

 
Figure 42 Topology for Global Arguments 

 
Once the topology is created, save it and name it distortion. We are ready to define 
arguments for the topology. The cubepoly block will introduce nonlinear distortion. The 
addnoise  block will add noise to the signal. There is a parameter which is common to the 
sine and spectrum block, that is, the sampling rate. Instead of changing it for each block, 
we will define a global argument parameter called Sampling Rate. We will then connect 
the global parameter to each block’s Sampling Rate parameter. But first, we will create an 
argument for the number of samples to generate. We will also create other arguments that 
will be connected to block parameters. 
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To create the “Number of Samples”  argument, click on the arguments icon in the tool 
bar or select arguments from the Blocks pull down menu. The argument dialog will 
appear shown in Figure 43. 
 
 
 
 

 
Figure 43 Arguments Dialog 

 

 
Click on the AddArg button. The argument definition dialog box shown in Figure 44 
appears. Fill in the prompt and value as shown. Also, very important, select the int radio 
button for the type.  
 
 
 

 
Figure 44 Arg Dialog Box 
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When you click on OK, the dialog disappears and the HBlock Arguments dialog is 
updated as shown in Figure 45. 
 
 

 
Figure 45 Updated Args: Number of Samples Arg 

 
 

 
By following the same procedure, add the Sampling Rate, Cubic Factor and Noise global 
arguments. See Figure 46. Note that arguments are identified by numbers starting from 
zero. 

 
Figure 46 Global Arguments 

 
The next step is to connect the global arguments to the block arguments. At this point 
make sure you save your work. Click on the sine block and select “Change Parameters” 
from the Block popup menu. The sine parameter dialog box appears. Change the “total 
number of samples to output” argument to arg0. That is type arg0 as the parameter value. 
Also set the sampling rate to arg1. Observe that arg1 is the sampling rate in Figure 46. 
Click on OK. Open the sine block parameter box again and notice that the parameters 
now reflect the global argument values. Figure 48 shows that the Sampling Rate for the 
spectrum block also points to arg1. Set the parameters for the addnoise and cubepoly 
blocks as shown in Figures 49 and 50. Save your work. 
 
 



(c)1989-2016 Silicon DSP  Corporation 47 Capsim Tutorial 

 
Figure 47 sine Block Arguments with Connection to Arguments 

 
 

 
Figure 48 spectrum Block Parameters 

 
 

 
Figure 49 addnoise Parameters with Argument 
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Figure 50 cubepoly Parameters with Arguments 

 
 
When you save your work, the file distortion.t is updated. This file is a text file that 
describes the topology including the arguments. You may want to review this file to see 
how the arguments are stored. The result of running the simulation is shown in Figure 51. 
Notice that the spectrum has a maximum frequency of 16000 Hz which is half the 32000 
Hz sampling rate. The spectrum block received this value from the global argument. 
 
 
 

 
Figure 51 Result of Simulation 
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Try increasing the non-linear distortion by modifying the global argument arg 2. Set it to 
say 2. Run the simulation. Compare the result with your previous simulation. Note that 
the third harmonic increased. You can see this by expanding sin3(x). If you want to create 
an overlay plot, select stack and overlay options from the Plot menu. Select frequency 
domain. Then select overlay plots to compare the plots in the frequency domain.  

 
 

Arguments as Global Parameters 
 
As was shown in the previous example, arguments can be used to implement global 
arguments. An example of a global argument is the number of samples in multiple source 
blocks. Figure 53 shows the idea behind using arguments as global parameters. 
 

 
Figure 52 Arguments as Global Parameters 
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Actions on Multiple Blocks 
 
 
On many occasions you need to manipulate a group of blocks. Examples are when you 
want to move a number of blocks, delete them, or convert them into an HBlock. The Edit 
pulldown, shown in Figure 54,  provides the means for multiple block editing. 
 

 
Figure 53 Edit Menu Showing Block Manipulation Items 

 

Selecting Multiple Blocks 
 
The procedure for selecting a group of blocks is shown in Figure 55 through Figure 58. 
We will work with the example topology shown in Figure 62.  First click on the Select 
menu in the Edit pulldown menu, Figure 54. We want to enclose the blocks to be selected 
in a bounding box. After you click on Select, move the cursor to the workspace. It should 
turn into a hand. Move the hand to the lower left corner of the bounding box as in Figure 
56 and click the mouse (make sure to release the mouse button).  Next move the hand 
cursor to the upper right corner and click the mouse as in Figure 57.  The selected blocks 
are indicated by the check mark as shown in Figure 58. 

Block A Block B Block C Block D

Block E

 
Figure 54 Blocks 
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Block A Block B Block C Block D

Block E

Click here to set anchor

 
Figure 55 Start of Selecting Blocks 

 

 

Block A Block B Block C Block D

Block E

Selection Box

Anchor

Click here to set

upper right corner

 
Figure 56 Bounding Box 

 
 

Block A Block B Block C Block D

Block E

 
Figure 57 Selected Blocks 

 

Removing Multiple Blocks 
 
To remove selected blocks, click on the Remove pulldown menu item in the Edit menu. 
The blocks will be removed along with all connections to and from the blocks. Note that 
if all the blocks in the topology are selected, one block will still remain. You can delete 
this block with the block popup menu remove menu button. 

Block A Block D

Block E

 
Figure 58 Selected Blocks Deleted 
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Moving Multiple Blocks 
 
To move multiple blocks, select them as described above. Next select the Move menu 
from the Edit pulldown menu.  Move the cursor to the workspace. A rubber band will 
appear anchored at the center of the bounding box, as in Figure 60. Move the tip of the 
rubber band to the desired new center of the bounding box. Click the mouse. The blocks 
and the connections will be moved. See Figure 60. 

Block A Block B Block C Block D

Block E

Block A

Block B Block C

Block D

Block E

 
Figure 59 Moving Selected  Blocks 

 

Converting Multiple Blocks to an HBlock 
 
You can create HBlocks from blocks within a universe or HBlock. This is a very useful 
option. To create an HBlock first select the blocks using the procedures described above. 
Next select Create a HBlock from the Edit pulldown menu. You will be prompted for a 
HBlock name. Note that after you create the HBlock you can use it immediately. 
However, it will be at the bottom of the HBlock list. For an example see Figure 61. Note 
that all connections from selected blocks to other blocks become output terminals. All 
connections from blocks to the selected blocks become input terminals. 
 



(c)1989-2016 Silicon DSP  Corporation 53 Capsim Tutorial 

Block A Block B Block C Block D

Block E

Selection Box

 
(a) 

Block B Block C

Block A Block D

Block E

New Galaxy

 
(b) 

Figure 60 Creating an HBlock and Replacing the Blocks 
 

 
 

Replacing Multiple Blocks With an HBlock 
 
This is a powerful option since the HBlock is created and replaces the selected blocks. 
You can test the HBlock within the universe to check functionality. The procedure is the 
same as in converting multiple blocks to a HBlock, except that after you specify the 
HBlock name, the blocks are replaced by the HBlock. As an example, Figure 62 shows 
the distortion topology  that was previously created.  
 
First we select the cubepoly and addnoise blocks. Next we select the “Create HBlock and 
Replace” menu  item from the Manipulate  pulldown menu.  We type in the name of the 
HBlock as channel. The blocks will be replaced with the channel HBlock as shown in 
Figure 63. In Figure 64 we see that the cubepoly and addnoise blocks have been replaced 
by the channel HBlock. Figure 65 shows the channel HBlock using the “Down One 
Level” from the block popup menu. Note the output of the addnoise block is now an 
output terminal. 
 
NOTE: Remove all probes before creating HBlocks using the Manipulate menu. 
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Figure 61 Selecting Blocks 

 

 
Figure 62 Naming the HBlock 
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Figure 63 Blocks Replaced with channel HBlock 
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Figure 64 Drilling Down the HBlock 

Multi-Rate Signal Processing, Eye Diagrams and 
Stacked Plots 
 
In this tutorial we will demonstrate multi-rate signal processing, eye diagrams, and the 
logic analyzer probe for generating stacked plots. 
 
Create a new universe called baseband using the blocks indicated in Figure 66. The 
blocks are from left to right, bdata,linecode,sqrtnyq,addnoise,sqrtnyq and eye.  Save the 
universes as baseband. Note that using the option in the Command Menu in the menu bar 
we have displayed the options and turned on “Show Block Names”. 
 
The bdata block generates pseudo random bits, one bit at a time at the bit rate. We can 
arbitrarily say that the bit rate is 1 Mega Bits per Second (Mbps). The linecoder block 
encodes the bits into bipolar format ( -1 for a "0" and +1 for a "1"). The line coder also 
increases the sampling rate. In this simulation we will oversample by 8. Thus each baud 
interval will be 8 samples. Each bit that is generated by the bdata block will result in 8 
samples generated by the linecode block. The linecode block generates the encoded data 
as impulses.  Each impulse is filtered by the sqrtnyq block for pulse shaping. Pulse 
shaping is necessary for zero inter-symbol interference. It will also bandlimit the signal. 
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The channel is modeled as an additive noise channel. The pulse shaping is split between 
the transmitter and receiver for an overall Raised Cosine pulse shape. Thus the sampling 
rate at the output of linecoder is 8*1Mbps=8 MHz.   
 
Run the simulation. You should get the eye diagram shown in Figure 67 where we are 
using 100% excess bandwidth. 
 
 

 
Figure 65 Showing Block Names 
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Figure 66 Eye Diagram 

 

 
In order to see what is going on, let us plot the signals in the system. Rather than creating 
individual plots with the plot probe, we will use the logic analyzer probe. This probe is 
not limited to digital signals as the name implies but can plot any signal.  
 
Add a logic analyzer probe to the output of the bdata block, the linecoder block, and the 
second sqrtnyq block as shown in Figure 68.  When you run the simulation you will not 
get the stacked plots. To display the logic analyzer probes, select “Stack Selected Plots” 
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from the View  pulldown menu. The stacked plots should popup as shown. You can also 

use the logic analyzer icon from the toolbar . 
 

 
 

 
Figure 67 Stacked Plots Showing Multirate Sampling 

 

 
 
Using the logic analyzer probe and stacked plots you can easily see what is going on. In 
particular the multi-rate sampling process and pulse shaping is clearly demonstrated.  
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Try changing the roll off factor and adding noise to see the effects on the eye diagram.  
Note that the rolloff factor for both Nyquist filters should be the same. Use a global 
argument to set them. 
 

Multiplot Block and the Logic Analyzer Probe 
 
Capsim provides many plotting options for the visualization of simulation results. The 
multiplot block and the logic analyzer probe are useful when a number of signal have to 
be compared. Build the topology shown in Figure 69. Multiple signal generators are 
connected to the multiplot block (wave, pulse, sine and gauss). The multiplot block 
supports auto fan-in and will create a plot with overlaid curves where each curve 
represents samples gathered from the input buffers.  Set the parameters of the pulse block 
as shown in Figure 70. Set the “Period in samples” and the “Pulse width in samples” as 
shown. Also set the parameters in the wave blocks as shown in Figure 71.  
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Figure 68 Multiplot 
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Figure 69 pulse Block Parameters 

 

 
 

 
Figure 70 wave Block Parameters 

 

 
 
Overlaid plots are one way to look at multiple data sets. Another is to use the logic 
analyzer probe. Add a logic analyzer probe to each connection as shown in Figure 72. 

When you run the simulation, click on the logic analyzer icon   or select “Stack 
Selected Plots” from the View pulldown  menu to see the stacked plots. Note that all 
curves share the same x axis but have independent y axis.  
 
In the simulation in Figure 72, you may have to set the parameters to get exactly what 
appears in the plots, particularly the wave blocks. Try different settings. 
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Figure 71 Results of Simulation with Logic Analyzers 
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Complex Buffers and the Complex Plot Block 
 
This block diagram will illustrate complex buffers and the cxplot block which is used as a 
probe block to plot complex samples. Build the topology shown in Figure 73. 
 
Complex buffers in Capsim transfer complex floating point samples. Each sample is one 
unit consisting of a real part and an imaginary part.  The block cxmakecx will convert two 
floating point  buffers connected to its input into a single complex buffer. Buffer 0 is the 
real part and buffer 1 is the imaginary part. The block cxmakereal converts a complex 
buffer into two real buffers. The real part is output on buffer 0 and the imaginary part on 
buffer 1. 
 
The probe block cxplot is connected to complex buffers and provides a mechanism to 
view both the real and imaginary parts.  

 
Figure 72 Topology to Illustrate Complex Buffers 
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Figure 73 cxplot Plots both the Real and Imaginary Parts of Complex Buffers 

 
 
After building the block diagram in Figure 73, run the simulation. There is no need to 
change any parameters. The plots shown in Figure 72 will appear. Note that the sine 
wave is the real part and the gaussian samples are the imaginary part of the complex 
buffer at the output of cxmakecx.  Here they are one unit. cxplot produces an overlaid  
two curve plot of the real and imaginary parts. cxmakereal then separates the real and 
imaginary parts into two buffers which are connected to plot blocks. The original sine 
wave and gaussian process are recovered. 
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Pole Zero Analysis 
 
Included with Capsim is an integrated pole-zero analysis package. This package allows 
you to analyze pole-zero diagrams from data stored in files, or to create pole-zero 
diagrams from scratch. The impulse response and frequency response can be computed. 
Poles (zeroes) can be added or deleted from the pole-zero diagram or they can be moved. 
 
Open the tutorial for filter design, shown in Figure 75,  and click on the iirfil block to 
popup the block menu. Select parameters. The parameters are shown in Figure 76. Note 
that by default the iirfil block designs a lowpass filter. Look at parameter 11. This 
parameter allows you to specify a name for the designed filter. The default is tmp. When 
the filter is designed, the filter poles and zeroes will be stored in tmp.pz, the cascade 
sections in tmp.cas and the filter data in tmp.dat. Since we have already run a simulation, 
the file tmp.pz must exist. If you are in doubt run the simulation again. 
 
 

 
Figure 74 IIR Filter Impulse Response 

 

 
 
 

 
Figure 75 iirfil Default Parameters 
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When you run the simulation, the poles and zeros are stored in a compact form in the file 
tmp.pz. The contents of this file for the default low pass filter is shown in Figure 76. Note 
the sampling rate of 32000 Hz and the normalization factor of 37.285336. To obtain a 
pole-zero diagram of the IIR filter, click on “Open Pole Zero File”  in the Filter Design  
Pulldown menu in the Capsim menu bar, see Figure 77. The file tmp.pz is probably the 
only file on the list with *.pz. Select it and click on OK.  You should get the pole-zero 
diagram shown in Figure 78.   
 

 
Figure 76 tmp.pz File Contents 
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Figure 77 Filter Design Pulldown Menu 
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Figure 78 Pole-zero Layout for tmp.pz File. Also Shown is the Pole-zero Toolbar. 

 
 
 

To calculate the impulse response and frequency response select the Tools ...  menu item 
from the Filter Design  pulldown menu. The tool box shown in Figure 79 will appear. 

Simply click on the calculator icon  ( next to last by the trash can) and the plots will 
appear. See Figure 79. 
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Figure 79 Pole-Zero Analysis After Calculation 

 

 
 

 
Place the plots in a corner. You may also resize them. You can now edit the pole-zero 
diagram using the tool box. For example you can move pole/zeros and see their effect on 
the impulse and frequency response. To get the group delay, select Options in the Filter 
pulldown menu. You can also change the number of points used to compute the 
responses. You can also save the pole-zeroes in a file and generate various IIR filter 
structures ( normalized lattice, direct form, and cascade form). Capsim has blocks that 
read these structures and simulate the filters. These are nl,casfil,dffl for normalized 
lattice, cascade and direct form filters. 
 
Poles and zeroes are stored in a compressed format. That is complex poles/zeroes are 
specified only once omitting the conjugate. Real poles/zeroes are distinguished by having 
zero imaginary parts. The number of poles/zeroes specified in the file is equal to the 
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number of real poles/zeroes plus the number of complex pairs.  Figure 76 shows the 
contents of the tmp.pz file.  
 
 
 
To reset the pole-zero analysis mode ( which you enter when you select any of the tools 

in the tool box), click on the RESET icon . This will allow you to modify plots. Do 
this if you get an error message, since you have to leave pole-zero editing mode once 
entered from the tool box.  
 

Note: To move a pole-zero first select the move icon . Next click the mouse with the 
cursor as close as possible to the pole-zero you intend to move. This will select it. Next 
move the cursor to where you want to move the pole/zero and click the mouse. Click and 
the pole or zero will move to that location. To trash pole-zeroes select as described, but 
then click the trash icon.   
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Appendix A: Block Popup Menu Description 
 
The following is a description of the options in the block popup menu: 
 
(1) Connect an Input: 
 To connect an input to the block. The cursor will turn into a question  
 mark. Select the block which will be connected to THIS block. 
 
 If you click on an empty area of the workspace, an INPUT TERMINAL will 
 be created.  
 
(2) Connect an Output: 
 Use this option to connect the block to another block. Again the 
 cursor will change to a question mark so that you can click on the 
 desired block. 
 
 If you click on an empty area in the workspace, an OUTPUT TERMINAL will 
 be created. 
 
(3) Change Parameters: 
 This menu option will bring up a parameter dialog box for the block. 
 You can change the parameters by typing into the text fields  of 
 each parameter. You can also use the TAB key to move between parameter 
 text fields ( if modal is on, see graphics help). 
 
(4) Move Block: 
 An outline of the block will appear so you can move the block to  
 a new location. Connections will also be moved. 
 
(5) Move Blocks: 
 Same as using select and move from the edit pulldown menu.  
 See edit help. 
 
(6) Replace: 
 This option allows you to replace the block with either a block or 
 a HBlock. A block or HBlock list will appear. Once a block has been  
 selected, click on Okay and the block will be replaced in place. 
 Connections are preserved. 
 
(7) Delete(Repair Connections): 
 
 This option will remove the block but will repair connections. Thus 
 if blocks A, B and C are connected, using this option on block B 
 will remove it and connect A and C together. 
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(8) Examine Source Code: 
 
 This option will create a window and display the block source code or  
 HBlock topology. A path must exist to the BLOCKS directory or the 
 directory in which the block source code resides. Use the command: 
  path s ../BLOCKS 
 for example. This command can be placed in the .capsimrc file so 
 that it executed on blocktup, or it can be entered via the Capsim 
 Line Command Option from the Special Pulldown menu. 
 
(9) Info: 
 This option will display information about the block. For example, 
 its parent HBlock, input/output connected blocks, etc. 
 
(10) Rename: 
 This option will rename the block. Normally when blocks are created 
 and placed on the workspace, their names are automatically generated. 
 This is the block model name followed by a number indicating the 
 instance of the model. For example if three sine blocks have been 
 placed on the workspace, their names will be  
  sine0, sine1, sine2 
 Using this option you can name the block Oscillator for example. 
 
(11) Duplicate: 
 
 This option will create another block of the same type. An outline 
 of the block will appear so you can place it at a new location in 
 the workspace. Click on the left mouse button once its location 
 has been determined. 
 
(12) Make Contiguous: 
 
 In many cases, after connecting and disconnecting connections from 
 a block, the buffer numbers  become non-contiguous.  
 For blocks such as adders and nodes and many others, the buffer 
 numbers are not significant. So by using this option all buffer 
 numbers are made contiguous.  
 
 This option should not be used for blocks in which buffer numbers are 
 significant. For example, in an adaptive filter, buffer 0 may the 
 the error, buffer 1 the desired response, etc.  
 
(13) Down One Level: 
 
 This option is valid for HBlock blocks. It allows you to create 
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 a new workspace window displaying the HBlock topology.  
 You can view and edit the HBlock. To make a workspace the current 
 workspace, click the left mouse button in an empty are of the 
 workspace.  
 
(14) Exit: 
 This option will popdown the menu without doing anything    
 in the HBlock workspace  
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Appendix B: Connection Popup Menu Description 
 
Remove Connection: 
 This option will remove the connection between the blocks. 
 There is no undo command. 
 
 
Redraw (Same Numbers): 
 This handy option allows you to redraw the connection. A pencil 
 cursor will appear. Start at the beginning block. Click the Mouse. 
 Move to the location you want a line, click the mouse and so forth. 
 At the ending block double click the mouse to terminate. 
 
 
Renumber ( Same Line): 
 
 This option will allow you to change the buffer numbers of a  
 connection. This may be necessary to force the connection to  
 correspond to its functionality per the block documentation. 
 You may also want to explore using the Make Contiguous option in 
 the block popup menu. 
 
 
Name Signal: 
 
 Names the signal. Displays the signal name in the workspace. Uses  
 the name in probes and logic analyzers to identify the signal. 
 
Insert a Block: 
 
 Breaks the connection and inserts either a block or HBlock between  
 two blocks. 
 
Probes: 
 
 Adds a probe to the connection. A probe dialog box will appear. 
 Multiple probes can be added. Use this option to change a probe’s 
 parameters also. 
 
Delete Probes: 
 
 Deletes all probes in a connection. 
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Pace Option: 
 Brings up the pace option dialog box. This allows you to designate  
 the connection as a pacer. This is only a graphical effect. That 
 is no actual pacing is done. The connection will appear as a 
 dashed line. By using the Options Dialog Box from the special 
 pulldown menu, pacers can also be hidden. 
 
Make Orthogonal: 
 
 Makes connections orthogonal. Only works with connections with less  
 than four lines. 
 
Exit Menu: 
 
 Exit the popup menu without doing anything. 
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Appendix C: Command Line Graphic Settings  
 
Various graphic options can be set using the “graphic” command. 
 
For example to display block names you use 
 graphic name on 
The graphic command can be invoked in .capsimrc or through the command line option 
in the Special pulldown menu. 
 
Here are the options: 
 
Turn auto connect on or off: 
 graphic auto on(off) 
 
Turn fast connect on or off: 
 graphic fast on(off) 
Display block name, connector buffer or arrows on connections: 
 
 graphic name on(off) 
 graphic buffer on(off) 
 graphic arrow on(off) 
 
Hide or show pacers: 
 
 graphic pacer on(off) 
 
The following changes how dialogs appear and also is used in  DecWindows and Open 
look where we need to set graphic modal on. 
 
With Motif window managers you want graphic modal off. 
 graphic modal on(off) 
This will allow you to use the apply button without popping down the dialog.  
 
However, to use the TAB key to move between text fields you will need to set modal on.  
 
Most of the above options can be set using the Options dialog box. However, the 
commands allow you to setup defaults using the .capsimrc file. 
 
 
 
 
 
 


